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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
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This section describes the features of the HSL-CUP4 Cupper High 
Speed Logic module. This includes the functional description, alarms 
detected, interlocks between the module and the existing control 
system, etc. 
 
 
________________________________________________________ 
1.1 FEATURES 
 
• Performs the high-speed control functions of the Cupper to speeds 

in excess of 300 SPM. This includes clutch control, air strip 
control, as well as die protection (die jam and cup jam detection). 
 

• Rapid response control of clutch/brake system for emergency 
stops (die protection) as well as precise TDC stops. The clutch 
solenoid outputs of the HSL-CUP4 are not intended as safety 
contacts for the cupper clutch and must not be the only interrupt to 
the clutch solenoids. 
 

• Accurate die jam (no cup drop) and cup jam detection for up to 
16-out presses. 
 

• Highly repeatable air strip control to reduce die jam problems. 
 

• Brake Wear compensation (Auto TDC timing programming) 
algorithm to stop press at TDC regardless of brake response. 
Brake response determination allows displaying of actual brake 
response (in degrees). Brake response alarm to indicate when 
brake stopping response (in degrees) has exceeded user preset 
limit. 
 

• Lubricator speed reference (0-10volt analog output) provides 
reference to lubricator proportional to speed of cupper (user 
scalable). 
 

• Alarm detection: die jam detection, cup jam detection, scrap jam 
detection, timing signal fail detection, clutch output failure 
detection, no ram motion alarm, resolver failure detection, and 
brake response too long alarm. 
 

• Data Acquisition: Total number of strokes and total number of die 
jam/cup jam faults for each station (for both current shift and last 
shift). 
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• Built-in 2 Line X 40 character sealed display with 24 key 
membrane keypad allows local viewing of collected data (stroke 
count, die jams per station, brake response) by operator and set-up 
of all user variables (passcode protected or key switch enabled) by 
authorized personnel. 
 

• Interfaces directly with machine mounted resolver, cup drop 
sensors and all clutch and air strip solenoids. 
 

• Based on high performance M4503 PLC/PLS module, that allows 
easy trouble-shooting and user customization using SYSdev 
(DOS-based) programming package. 
 

• Built-in PLS provides all machine timing, eliminating need for an 
additional PLS. 

 
 
________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The HSL-CUP4 cupper high speed logic module is an electronic 
upgrade for cuppers and performs the high speed control functions of 
the cupper including:  
• Rapid Response Clutch/Brake Control 
• Accurate Die Jam/Cup Jam Detection 
• Precise Air Strip Control. 
 
Included is a “Brake Wear Compensation” feature, that automatically 
adjusts the TDC timing signal to stop the press at TDC regardless of 
brake stopping time. 
 
Alarm detection is provided including:  
• Die Jam Detection 
• Cup Jam Detection 
• Scrap Jam Detection 
• Timing Signal Failure 
• Clutch Output Failure Detection 
• No Ram Motion Alarm 
• Resolver Failure Detection 
• Brake Response Too Long Alarm 
 



SECTION 1 
GENERAL DESCRIPTION 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 3 - 

Data collection includes (for both the current and previous shift):  
• Total Stroke Count 
• Die Jam/Cup Jam Faults Per Station Count 
 
Interfaces directly to the machine mounted resolver, cup drop sensors, 
clutch/brake, and air strip solenoids as well as the host PLC via 
discrete DC I/O. 
 
The HSL-CUP4 is not a dedicated “black box”, but is instead 
implemented using the high performance SYSTEMS M4503 
PLC/PLS module. This allows easy customization by either SEA or 
the end user. The M4503 module is programmed using the SYSdev 
programming package, that allows the module to be programmed in 
any combination of Ladder or High-level (subset of “C”), as well as 
perform on-line monitoring and trouble-shooting. The M4503 module 
incorporates a built-in PLS that interfaces directly with the machine 
mounted resolver and provides all machine timing, eliminating the 
need for an external PLS. 
 
 
________________________________________________________ 
1.3 CLUTCH/BRAKE CONTROL 
 
The clutch/brake solenoids are activated by the HSL-CUP4 through 
the electro-mechanical two-hand control circuitry provided externally 
by the user. The throughput of the HSL-CUP4 is 0.5 milliseconds. 
This fast throughput along with the fact that the PLS is fully 
integrated with the processor, allows extremely fast and repeatable de-
clutching and braking response to be achieved. Normally the clutch is 
controlled via inputs on the HSL-CUP4 that are controlled from 
outputs on the host PLC. However, detection of any of the alarms (die 
jam fault, cup jam fault, etc.) results in an immediate de-clutch of the 
solenoids. 
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________________________________________________________ 
1.3.1 CONTROL OF CLUTCH VIA HOST PLC 
 
Six discrete DC inputs to the HSL-CUP4 from the host PLC are used 
to control the clutch:  
• Clutch On No.1 
• Clutch On No.2 
• Continuous Mode 
• Single Mode 
• Inch/Bar Mode 
• Not Immediate Stop 
 
The HSL-CUP4 is essential a high speed gate which implements the 
TDC stop, single, inch, and bar clutch control, all based the states of 
the six inputs listed above. The following description of operation 
defines the requirements of the host PLC logic to activate the clutch 
through the HSL-CUP4: 
 
Continuous Mode: 
1) To activate the clutch in continuous mode, turn both the “Clutch 

On No.1” and “Clutch On No.2” inputs “on” simultaneously while 
the “Continuous Mode” and “Not Immediate Stop” inputs are 
“on”. The “Single” and “Inch/Bar” inputs must be “off”. 

 
2) To perform a TDC stop, turn both the “Clutch On No.1” and 

“Clutch On No.2” inputs “off” while leaving the “Not Immediate 
Stop” input “on”. 

 
3) To perform an immediate (emergency) stop, turn both the “Clutch 

On No.1” and “Clutch On No.2” as well as the “Not Immediate 
Stop” inputs “off” simultaneously. The “Not Immediate Stop” 
input is used to indicate to the HSL-CUP4 that the clutch should 
be disengaged immediately, not waiting for the TDC timing 
signal. 

 
 
Single Mode: 
1) To single stroke the press, with the “Single Mode” and “Not 

Immediate Stop” inputs “on”, turn the “Clutch On No.1” and 
“Clutch On No.2” inputs “on” simultaneously for 5 to 50 
milliseconds. The press will make one stroke. Both the 
“Continuous” and “Inch/Bar” mode inputs must be “off”. 
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Inch Mode: 
1) To inch the press, with the “Inch/Bar” mode and “Not Immediate 

Stop” inputs “on”, simultaneously turn “on” and “off” both the 
“Clutch On No.1” and “Clutch On No.2” inputs. The clutch is 
activated as long as both inputs are “on”. Both the “Continuous” 
and “Single” mode inputs must be “off”. 

 
 
Bar Mode: 
1) With both the “Inch/Bar Mode” and “Not Immediate Stop” inputs 

“on”, the clutch can be activated by simultaneously turning both 
the “Clutch On No.1” and “Clutch On No.2” inputs “on”. The 
clutch is activated as long as both inputs are “on”. Both the 
“Continuous” and “Single” mode inputs must be “off”. 

 
Note: In all the above modes, the “Clutch On No.1” and “Clutch On 
No.2” inputs must be turned “on” simultaneously (within 0.5 seconds) 
in order for the clutch to activate. 
 
Refer to the schematic at the back of this manual for typical HSL-
CUP4 clutch connections. 
 
________________________________________________________ 
IMPORTANT SAFETY WARNING - The HSL-CUP4 is intended 
as a high speed logic gate to provide consistent and accurate 
clutch control. It is not designed as a redundant, dual-processor 
clutch brake safety module. The HSL-CUP4 must not be the only 
means of controlling the cupper clutch mechanism. Good design 
practice dictates the use of safety interlocks on any device that 
starts or stops automatically that can cause personnel injury to 
operating or maintenance personnel. The HSL-CUP4 must be 
used only in conjunction with industry approved safety interlock 
contacts, implemented in accordance with ANSI B11.1 safety 
requirements, otherwise serious personnel injury may result. 
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________________________________________________________ 
1.4 AIR STRIP CONTROL 
 
The HSL-CUP4 provides a repeatability of 0.5 milliseconds for the air 
strip thus reducing die jam problems. “Air Strip (Low)”, “Air Strip 
(Mid)”, and “Air Strip (High)” timing signals are provided to activate 
the air strip when the press is running in the respective speeds. 
 
 
________________________________________________________ 
1.5 BRAKE WEAR COMPENSATION 
 
The HSL-CUP4 incorporates a brake wear compensation or automatic 
TDC timing feature, which stops the press at TDC regardless of the 
actual braking response of the clutch/brake. The stopping 
compensation is accomplished by automatically adjusting the TDC 
timing signal based on the previous stop. Any overrun is detected and 
a new TDC timing signal is computed such that the machine will stop 
at the desired location on the next stop. Three TDC signals are 
provided (one for low speed, one for mid speed, and one for high 
speed). The mid and high speed TDCs incorporate the break wear 
compensation feature. The appropriate TDC timing signal (mid or 
high) is adjusted based on the speed of the machine when the TDC 
stop was initiated. 
 
In addition to the brake wear compensation, the HSL-CUP4 also 
calculates the actual brake response (in degrees). This is the number 
of degrees from where the clutch was de-activated (TDC timing 
location) to where the crankshaft actually ended up stopping. This can 
then be displayed by the operator or maintenance personnel to 
determine the condition of the brake. 
 
A “Brake Response Too Long” alarm is also generated when the 
actual brake response exceeds a user specified maximum allowed 
brake response. This can be used to indicate that service to the brake 
should be performed. 
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________________________________________________________ 
1.6 ALARM DETECTION 
 
The package detects the following alarms:  
 
Die Jam Detection: The “Cup Drop Window” timing signal 
(CH06), along with the machine mounted cup drop sensors, are used 
to verify that the cups drop correctly each stroke. The cups for each 
station must drop inside the “Cup Drop Window” in order to avoid a 
die jam alarm. If a cup from any station fails to drop inside the “Cup 
Drop Window”, a “Die Jam Alarm” is generated for that station. The 
clutch is then de-activated for a TDC stop and the station number that 
failed is displayed on the Keypad/Display. Die jam protection is 
provided for up to 16 stations 
 
Cup Jam Detection: The “Cup Drop Window” timing signal 
(CH06), along with the machine mounted cup drop sensors, are used 
to verify that the cups do not jam in front of the cup drop sensors. If a 
cup for any station is detected outside the “Cup Drop Window” 
timing, a cup jam alarm is generated for that station. The clutch is 
then de-activated for a TDC stop and the station number that failed is 
displayed on the HSL-CUP4 display. Cup jam protection is provided 
for up to 16 stations. 
 
Scrap Jam Detection: This alarm occurs when the “Scrap Jam” 
input is turned “on”. This is generally derived from the grounded 
scrap discharge and is activated when scrap backs up shorting the 
discharge. The clutch is de-activated for a TDC stop at the detection 
of this fault. 
 
Timing Signal Fail: The timing signal fail occurs when any of the 
timing signals generated in the PLS section fail to change state 
periodically while the machine is running. 
 
Clutch Output Fail (No.1/No.2): These alarms occur when the 
respective clutch output (no.1 or no.2) fails either “on” or “off”. This 
indicates either a failure in the outputs of the S4568 board that drives 
the clutch or a short circuit or open circuit in the clutch output wiring. 
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No Ram Motion Detected: This alarm occurs when the clutch is 
activated and no ram motion is detected after a time delay. This could 
indicate either the clutch did not activate or that a failure in the 
resolver coupling has occurred. 
 
Resolver Fault - Motion Detected at Stop: This alarm occurs 
when motion is detected after the clutch has been disengaged for a 
time delay. This indicates either a broken wire in the resolver cable or 
a failure in the resolver windings. 
 
Brake Response Too Long: The “Brake Response Too Long” 
alarm is generated when the actual brake response exceeds a user 
specified maximum allowed brake response. This can be used to 
indicate that service to the brake should be performed. 
 
The “die jam”, “cup jam”, and “scrap jam” alarms are available to the 
host PLC as discrete outputs. The balance of the alarms, are summed 
together into the “Not HSL Alarm” discrete output. If any of the 
alarms occur, the “Not HSL Alarm” is turned “off”. If all alarms are 
cleared, the “Not HSL Alarm” is “on”. These outputs should be 
interlocked to the existing control system to disable the clutch logic. 
 
In the case of the “die jam” and “cup jam” alarms, four additional 
outputs representing the binary station number are also available such 
that the station that faulted can be read by the host PLC. The 
respective alarm message is displayed on the HSL-CUP4 display 
when the corresponding alarm is active. 
 
 
________________________________________________________ 
1.7 DATA COLLECTION 
 
The following data is collected for both the current shift and the 
previous (last) shift: 
 

1) Total number of strokes 
2) Total number of Die Jam/Cup Jam faults per station 

 
This data can be viewed locally on the display by the operator or 
production control personnel. This information is updated (“current” 
shift transferred to “Last” shift) based on the change of state of the 
“End Of Shift” input. 



SECTION 2 
INSTALLATION 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 9 - 

The HSL-CUP4 module is provided for door mounting on the existing 
user's control cabinet door or console. 
 
 
________________________________________________________ 
2.1 WHAT'S INCLUDED 
 
Verify that the following items are included when unpacking the 
HSL-CUP4 (back-panel mounting): 
 
1ea. HSL-CUP4 back-panel for mounting in existing control 

cabinet (includes the following): 
 

1ea. M4500 PLC/PLS Module with required I/O boards 
1ea. P4500 Power Supply 
1ea  D4591 Display with ribbon cable for mounting in the 

existing control cabinet door 
1ea. HSL-CUP4 User's Manual 
1ea. HSM-CUP7 Keypad Quick Reference 
1ea. M4500 User's Manual 
1ea. HSL-CUP4 Program Disk 

 
The following items are optional items and can be purchased 
separately as required or desired: 
 

1ea. RSV34-MS1 Resolver 
1ea. RSV-RSCBLE-XX Resolver Cable 

 
 
________________________________________________________ 
2.2 POWER REQUIRED 
 
The HSL-CUP4 is powered from 115/230VAC 50/60HZ and 
+24VDC. The 115/230VAC is used to power the M4500 module 
while the +24VDC is used to power the +24VDC I/O (sensors, clutch 
solenoids, etc.).  
 
Note: +24VDC solenoids must be used for all clutch and air strip 
solenoids. These provide a much more consistent and repeatable 
response time than 115VAC solenoids. Assuming +24VDC solenoids 
were used in the existing system, the +24VDC current required by the 
HSL-CUP4 is no more than the existing systems +24VDC current 
requirement, therefore the existing +24VDC power supply should be 
adequate. 



SECTION 2 
INSTALLATION 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 10 - 

________________________________________________________ 
2.3 MOUNTING THE HSL-CUP4 
 
The HSL-CUP4 module should be mounted in the existing cabinet. 
Perform the following steps to mount the HSL-CUP4: 
 
1) Refer to the “Recommended Cut-Out” in figure 1. Create a cut-out 

in the door of the existing control cabinet and mount the D4591 
display and connect the ribbon cable from the M4500 to the 
display. 

 
Note:  The D4591 must be located within 6 feet of the M4500 to 
avoid EMI pick-up on the display ribbon cable. 
 
 

________________________________________________________________________________ 

 
 

Figure 1 – D4591 Recommended Panel Door Cut-out 
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________________________________________________________ 
2.4 WIRING THE HSL-CUP4 
 
Referring to the electrical control schematic at the back of this 
manual, wire the HSL-CUP4 to the existing control system as follows: 
 
Note:  Keep all +24VDC wiring, resolver cable, sensor cable and 
lubricator speed reference wiring away from high voltage wiring. 
Wire the machine-mounted resolver directly to the 8-pin resolver 
input connector on the M4500. 
 
1) Incoming Power: 115VAC-230VAC to FU1, neutral to 900 and 

ground to GND. +24VDC to 501 and common to 500. 
  
2) Interlocks from existing control system to HSL-CUP4 (terminals 

I10 through I17). 
 
3) Interlocks to existing control system from HSL-CUP4 (terminals 

O24, O25 and O18 through O25). 
 
4) Main Clutch solenoids (O10 and O11).  Air Strip solenoids (FU4 

through FU7). 
 
5) Cup Drop Sensors (I24 through I39) using three conductor 

shielded cable. The shields of the sensor cables should be tied to 
earth ground at a terminal inside the existing control cabinet and 
left floating at the sensors. Any un-used cup drop inputs on the 
HSL-CUP4 should be tied to the “PLC Timing”, output O17. This 
defeats the die jam detection for the un-used stations by 
simulating a cup drop. 

 
6) Set-Up Enable, passcode by-pass (I19), key switch (if desired). 
 
7) Resolver cable from resolver or existing PLS to RO-S4 connector 

on M4500 using a three pair, two-conductor shielded cable. The 
shield of the resolver cable should be tied to the “SHLD” terminal 
of the resolver input connector. Make sure the resolver cable 
shield is left floating at the resolver. 

 
8) Lubricator Speed reference (0-10V analog output - 701,702) to 

lubricator drive (if used). It may be necessary to use an analog 
isolation amplifier (not provided) to isolate the drive from the 
M4500 to prevent damage to the module. 
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________________________________________________________ 
2.5 MOUNTING THE RSV34-MS1 RESOLVER  
(if required) 
 
The HSL-CUP4 is designed to interface to a resolver (not encoder) for 
machine timing. If the machine is not already equipped with a 
resolver, then the existing encoder will have to be removed and an 
RSV34-MS1 resolver will have to be mounted in it's place. If this is 
the case, refer to the RSV34-MS1 data sheet for details on mounting 
the resolver. Use the RSV-RSCBLE cable to connect the resolver to 
the HSL-CUP4. Route the resolver cable in a separate conduit, away 
from all other high voltage and control wiring. Wire the cable directly 
to the 8-pin resolver connector on the M4500 (see section 2.4). 
 
 
________________________________________________________ 
2.6 HSL-CUP4 SOFTWARE INSTALLATION 
 
The HSL-CUP4 set-up software is used to  
• Download the Program to the M4500 
• Tune (Set-Up) the User Adjustable Variables 
• Download and Upload (Save) the User Set-Up Variables to Disk 
• View Shift Data  
 
Follow the steps below to install either the Windows or DOS based 
setup programs and PLC application program on a PC used to support 
the HSL-CUP4 control system. 
 
 



SECTION 2 
INSTALLATION 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 13 - 

________________________________________________________ 
2.6.1 WINDOWS™ BASED SET-UP PROGRAM 
INSTALLATION 
 
The HSMCUP7 setup program is compatible with Windows 
95/98/ME/2000/XP operating systems. 
 
To install the set-up software, perform the following steps: 
 
1) Insert the HSL-CUP4 CD into the drive 
 
2) From the Windows desktop, “Click” Start and then select run. 
 
3) From the “Run” dialog box, “Click” the Browse button.   
 
4) Select the drive with HSL-CUP4 CD.  Select the “setup.exe” file 

and “Click” Open and then Ok. 
 
5) This will initiate the installation process.  Follow the instructions 

that appear on the screen to complete the installation process.  The 
HSMCUP7 setup program can be executed from the “Systems” 
folder located in Programs. 
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________________________________________________________ 
2.6.2 DOS BASED SET-UP PROGRAM INSTALLATION 
 
To install the DOS based set-up software perform the following steps: 
 
1) Create one directory off the root directory of the PC for each 

Cupper the HSL-CUP4 will be used on (called “HSLCUP1” for 
cupper #1, “HSLCUP2” for cupper #2, etc). These will be used to 
store the “HSLCUP4.EXE” setup programs and HSLCUP4 set-up 
data for each cupper. Create these directories by typing the 
following at the DOS prompt: 

 
MD  \HSLCUP1<ENTER> 
MD  \HSLCUP2<ENTER> 

etc. 
 
2) Install the disk labeled “HSL-CUP4 PROGRAMS” into the A: 

drive. For each “HSLCUP” directory you created in the previous 
step, switch to that directory and install the “HSL-CUP4” set-up 
programs by typing the following at the DOS prompt (cupper #1 is 
shown): 

 
CD  \HSLCUP1<ENTER> 
A:INSTALL<ENTER> 

 
3) Add each cupper's HSL-CUP4 set-up program to your computer's 

menu software by creating a selection for each cupper called 
“SET-UP CUPPER #1” for cupper #1, “SET-UP CUPPER #2” for 
cupper #2, etc.. The DOS commands executed for these selections 
should be (cupper #1 shown): 

 
For the “SET-UP CUPPER #1” selection: 

CD  \HSLCUP1 
HSLCUP4  HSLCUP4 
CD  \ 

 
4) To execute the respective cupper's set-up program, simply select 

the corresponding “SET-UP CUPPER” selection from the menu 
software's menu. 



SECTION 2 
INSTALLATION 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 15 - 

________________________________________________________ 
2.6.3 SYSdev PROGRAM DEVELOPMENT SOFTWARE 
INSTALLATION 
 
The SYSdev Program Development software is used to perform on-
line trouble-shooting and program modifications to the HSL-CUP4. If 
SYSdev was purchased with the HSL-CUP4 package and is not 
already installed on the your computer, install SYSdev onto the hard 
drive of your computer following the steps in the SYSdev Program 
Development manual. 
 
 
________________________________________________________ 
2.6.4 APPLICATION PROGRAM INSTALLATION 
 
The application program is a SYSdev based program, loaded into the 
M4500 module and performs the HSL-CUP4 logic. The program is 
written in a combination of Ladder logic and High-level. If the user 
desires to make program changes or perform on-line monitoring of the 
program execution the files, which constitute the HSLCUP4, the 
program will have to be loaded onto the hard drive of the PC used to 
support the system. The SYSdev Program Development Software will 
also have to be loaded on the PC. To install this program perform the 
following: 
 
1) Install the “PROGRAMS” disk into the drive.  
 
2) For each of the "HSLCUP4" directories (created in section 2.6.2), 

copy all the files from the disk to each of these subdirectories. 
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________________________________________________________ 
2.7 MODIFY EXISTING PLC PROGRAM 
 
Modify the existing control system PLC program to interface with the 
HSL-CUP4 by incorporating the following into the existing PLC 
ladder logic: 
 
1) The HSL-CUP4 now controls: 

• The Clutch TDC Stop 
• Air Strip 
• Die Jam 
• Cup Jam Detection 
 
Defeat the existing Die jam and cup jam detection in the PLC and 
add both the “Die Jam Alarm” and “Cup Jam Alarm” inputs from 
the HSL-CUP4 and the “No HSL Alarm” interlock.  

 
Note: These alarms must immediately disable the clutch logic in 
the PLC. The “Die Jam” and “Cup Jam” alarms are true logic 
(“ON” when alarm detected) while the “No HSL Alarm” is 
inverted logic (“off” when alarm is detected). 

 
2) Add the “Clutch On No.1” and “Clutch On No.2” outputs into the 

PLC logic. In general, these can be derived from the logic that use 
to drive the clutch solenoids by removing the TDC timing signal 
from the original logic. 

 
3) Add the “Continuous”, “Single”, and “Inch/Bar” Mode outputs to 

the existing PLC logic. The respective output should be “on” 
when the corresponding mode is selected. 

 
4) Add the “Not Immediate Stop” output to the PLC logic. This 

should be “on” when no E-stop or immediate stop condition is 
present and turn “off” as soon as either condition occurs. In 
general, the clutch control as interfaced with the above six 
interlocks, should be implemented as defined in section 1.3. 
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5) Add the “Coil Stock O'Ride” output into the PLC program. The 
signal is used to by-pass the die jam and cup jam detection when 
the press is stroked without coil stock.  

 
Note: The HSL-CUP4 will produce an “COIL STOCK MODE” 
fault if cups are detected dropping while the coil stock override is 
“on”. This prevents the machine from being run in production 
with the coil stock override accidentally left “on”. 

 
6) Add the “Alarm Reset” output. This signal should be “on” as long 

as the system reset push-button is depressed. 
 
 
________________________________________________________ 
2.8 HSL-CUP4 SET-UP 
 
The HSL-CUP4 is shipped from the factory with the PLC program 
loaded into the PLC section of the module. The PLS channel set-point 
file “CUP7TMG” loaded in the PLS section. In most cases, the 
following user variables and timing channels may have to be altered 
to tune the HSL-CUP4 to the actual cupper it is controlling. 
 
Once installed and the control system is powered back up, perform the 
following to set-up and tune the HSL-CUP4. The set-up is performed 
using the Keypad/Display or a PC running the set-up program. See 
section 3 for a description of the Keypad commands and menu 
displays of the HSL-CUP4 Keypad/Display. See section 4 for a 
description of the menus, variables and how to use the Windows 
based set-up program. See section 5 for a description of the menus, 
variables and how to use the DOS based set-up program. 
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________________________________________________________ 
2.8.1 DEFAULT SET-UP VARIABLES 
 
As shipped, the user variables for the HSL-CUP4 are set to the 
following defaults: 

 
Brake Wear Compensation: 
 Enabled  : N 
 Desired TDC Stop Position (Mid Speed)  : 000 
 Desired TDC Stop Position (High Speed)  : 000 
 
Maximum Allowed Stopping Response (degrees)  : 300 
 
Cupper Running Speeds: 
 Low Speed (SPM)  :100 
 High Speed (SPM)  :250 
 
Lubricator Speed Reference: 
 Maximum Speed  : 250 
 Idle Speed (Cupper stopped)  : 075 

 
The “CUP7TMG” timing channel file, as shipped, contains the 
following default timing set-points: 

 
CHAN  ON - OFF DESCRIPTION 
 
CH00: 120 - 140 TDC (High) timing 
CH01: 160 - 180 TDC (Mid) timing 
CH02: 200 - 220 TDC (Low) timing 
CH03: 120 - 200 Air Strip (High) timing 
CH04: 140 - 220 Air Strip (Mid) timing 
CH05: 150 - 230 Air Strip (Low) timing 
CH06: 140 - 120 Cup Drop Window timing 
CH07: 000 - 020 PLC Timing 
CH10: ___ - ___ 
CH11: ___ - ___ 
CH12: ___ - ___ 
CH13: ___ - ___ 
CH14: ___ - ___ 
CH15: ___ - ___ 
CH16: ___ - ___ 
CH17: ___ - ___ 
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________________________________________________________ 
2.8.2 SET CUPPER SET-UP PARAMETERS 
 
The Cupper set-up parameters include:  
• Enabling or Disabling The Brake Wear Compensation 
• Setting the Desired Mid and High Speed Stopping Points (if the 

brake wear compensation is enabled) 
• Setting the Maximum Allowed Stopping Response 
• Setting the Cupper Running Low and High Speeds 
 
Brake Wear Compensation: If the brake wear compensation is 
used, enable it by setting the “Brake Wear Compensation Enable” to 
“Y” and set the “Desired TDC Stop Position (Mid)” and “(High)”. 
The “Desired TDC Stop positions” is the location of the ram when it 
comes to rest after a TDC stop. Both the “Mid” and “High” desired 
stopping positions are generally set to 000 degrees. Enabling the brake 
wear compensation allows the HSL-CUP4 to automatically adjust the 
TDC timing channels (CH00-High) and (CH01-Mid) as necessary, 
such that the press will stop at the desired stopping position regardless 
of the actual brake response. 
 
If the brake wear compensation is not used, disable it by setting the 
“Brake Wear Compensation Enable” to “N”. Disabling the brake wear 
compensation requires the TDC (High) timing (CH00) and the TDC 
(Mid) timing (CH01) signals to be set manually such that the press 
stops at TDC.  
 
Note: If the brake response then changes, the press will not stop at 
the desired position if the brake wear compensation is disabled. 
 
Maximum Allowed Stopping Response: This parameter defines 
the maximum allowed brake response before a “Brake Response Too 
Long” alarm is generated. If the actual brake response (number of 
degrees from when the brake is activated to the position where the 
press ends up at rest) when a TDC stop is performed is longer than 
this number, the alarm is generated. If the actual brake response is 
less, the alarm is not generated. Set this parameter to the value where 
the brake response is considered too long and service to the brake 
should be performed (typically 270 to 300 degrees). 
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Cupper Running Speeds: Set the Cupper running “Low Speed” 
and “High Speed” to the speeds that the cupper will actually run at 
when the respective speed is selected.  
 
Note: This is not a speed reference but is instead parameters used by 
the HSL-CUP4 to know when to switch between the TDC (Low), 
TDC (Mid), and TDC (High) timing as well as the Air Strip (Low), 
Air Strip (Mid), and (High) timing etc. 
 
See section 3.5.1 (Using the Keypad/Display), section 4.5.2 
(Windows set-up program reference) or section 5.1.3 (DOS set-up 
program reference) for details on setting the set-up parameters. 
 
 
________________________________________________________ 
2.8.3 SET LUBRICATOR SPEED REFERENCES 
 
Set the “Lubricator Maximum Speed” and “Lubricator Idle Speed” as 
desired. These parameters are used to control the speed of the 
lubricator (via the 0-10Volt lubricator speed reference output of the 
HSL-CUP4 module). 
 
Lubricator Maximum Speed: The “Lubricator Maximum Speed” 
parameter is used to scale the 0-10VDC analog output such that when 
the cupper is running at the speed entered in “Lubricator Maximum 
Speed”, the analog output will be at 10 volts. 
 
Lubricator Idle (Minimum) Speed: This parameter determines 
the speed the lubricator will run at when the cupper is stopped (de-
clutched).  
 
Note: When the cupper is running, the lubricator speed reference is 
proportional (as set by the “Lubricator Maximum Speed” scaling) to 
the speed of the cupper. This parameter is used to provide the speed 
reference when the cupper speed is zero (for lubricator jog, etc.). 
 
See section 3.5.2 (Using the Keypad/Display), section 4.5.2 
(Windows set-up program reference) or section 5.1.4 (DOS set-up 
program reference) for details on setting the set-up parameters. 
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________________________________________________________ 
2.8.4 SET MACHINE ZERO 
 
Inch the cupper up to top dead center (TDC) and set the HSL-CUP4 
resolver offset. See section 3.5.4 (Using the Keypad/Display), section 
4.5.3 (Windows set-up program reference) or section 5.2.1 (DOS set-
up program reference) for details on setting machine zero. 
 
 
________________________________________________________ 
2.8.5 VERIFY LOCATION OF CUP DROP WINDOW (CH06) 
 
By inching the machine, verify that the “Cup Drop Window” timing 
(CH06) of the HSL-CUP4 first turns “on” at the point where the cups 
are first freed from the punches (see figure 2). This is the earliest point 
the sensors might see the cups drop. The “Cup Drop Window” should 
then be set to stay “on” all the way up to about 20 degrees before this 
location (this is almost one complete stroke). This allows the greatest 
amount of time for the cups to drop. 
 
The “Die Jam” alarm is generated if a cup from any station fails to 
drop within the “Cup Drop Window” timing (CH06). The “Cup Jam” 
alarm is generated if any cup is detected when the “Cup Drop 
Window” is “off” (cups must be clear by this time). 
 
See section 3.5.3 (Using the Keypad/Display), section 4.5.3 
(Windows set-up program reference) or section 5.2.2 (DOS set-up 
program reference) for details on setting the location of the cup drop 
window (CH06). 
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________________________________________________________________________________ 
 

 

 
 

Figure 2 – Cup Drop Check Timing Sequence 
 
________________________________________________________________________________ 

 
 
________________________________________________________ 
2.8.6 VERIFY MACHINE OPERATION 
 
Once steps 2.8.2 thru 2.8.5 are complete, run the machine in normal 
production (at all speeds where practical) and verify the following: 
 
Verify Air Strip Timing: With the machine running with the coil 
stock, verify that the cups are dropped with-out any problems (verify 
at low, medium, and high speed). If a problem is occurring, adjust the 
respective “Air Strip” timing (CH03-High Speed, CH04-Mid Speed, 
CH05-Low Speed) until the problem is corrected. See section 3.5.3 
(Using the Keypad/Display), section 4.5.3 (Windows set-up program 
reference) or section 5.2.2 (DOS set-up program reference) for details 
on adjusting CH03 thru and CH05. 
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Verify Cup Drop Timing: With the machine running with the coil 
stock, verify that no false die jam or cup jam faults are occurring. If 
false die jams or cup jams are occurring, verify that the cup drop 
sensors are detecting the cups when they drop. If the sensors are 
detecting the cups, adjust the “Cup Drop Window” timing as 
necessary to eliminate the false die jam or cup jam faults. The cups 
must drop inside the “Cup Drop Window” in order to avoid a die jam 
and must not be detected outside the “Cup Drop Window” in order to 
avoid a cup jam.. 
 
Verify that the die jam detection is working correctly by removing the 
coil stock from the press and then stroking the press with the coil 
stock override “off”. The press should stop with a die jam alarm for 
station #1 displayed (die jams for all stations actually occur, but #1 is 
displayed since it is the lowest numbered station to fault). 
 
Verify TDC Stops: If the brake wear compensation is enabled, 
verify that the press does stop at the desired location in both the high 
and the mid speeds.  
 
Note: When the HSL-CUP4 is first installed, it will take a few 
successive stops for the algorithm to program the TDC timing 
channels to the correct position. Also, the compensation is enabled 
after the press has been running at a fixed speed in continuous. The 
TDC timing channels will not be modified when single strokes are 
made or if press is started in continuous and then immediately stopped 
again. Wait about 5 seconds after the press is started before 
performing the TDC stop to verify the stop position. 
 
If the brake wear compensation is disabled, manually adjust both the 
TDC (High) timing (CH00) and the TDC (Mid) timing (CH01) such 
that the press stops at back dead center at both respective speeds.  
 
Note: The TDC (Low) timing must be set manually since it does not 
incorporate the compensation algorithm. See section 3.5.3 (Using the 
Keypad/Display), section 4.5.3 (Windows set-up program reference) 
or section 5.2.2 (DOS set-up program reference) for details on 
adjusting CH00 and CH01. 
 
The Machine Is Now Set-Up And Ready To Run! 
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________________________________________________________ 
2.9 M4500/P4500/D4591 INSTALLATION 
 
The following is provided as a reference only. These steps are 
performed by the factory prior to shipping the HSL-CUP4. These 
steps need only be performed in the event either the M4500 module, 
P4500 power supply, or D4591 display need to be replaced. Refer to 
the M4500 User's Manual for general details on installing the M4500, 
P4500, and D4591. 
 
 
________________________________________________________ 
2.9.1 M4500 MODULE INSTALLATION 
 
To install the M4500 module, perform the following: 
 
1) Remove the cover from the M4500 chassis (retained with three 

captive screws on the lower front of the cover and two captive 
screws on each side of the M4500 chassis). 

 
2) Install the S4568 (SLOT0-0, furthest left slot): Set the slot address 

dip switches (SW1) to the following positions: 
 

S4568:  SW1 switch1 = "OFF" 
SW1 switch2 = "OFF" 

 
3) Install the S4568 (SLOT0-1, slot next to S4568): Set the slot 

address dip switches (SW1) to the following positions: 
 

S4568:  SW1 switch1 = "ON" 
SW1 switch2 = "OFF" 

 
4) Install the S4563 (SLOT0-2, slot next to S4568): Set the slot 

address dip switches (SW1) to the following positions: 
 

S4563:  SW1 switch1 = "OFF" 
SW1 switch2 = "ON" 

 
5) Install the on the M4500, making sure all the board connectors 

protrude through the slots in the cover. Tighten the three captive 
screws on the lower front of the cover and the two captive screws 
on each side of the M4500 chassis. 
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6) Connect the display ribbon cable to the connector on the back of 
the M4500 (the connector will mate with the connector on the 
M4500 only one way). 

 
7) Mount the M4500 chassis to the HSL-CUP4 back panel using four 

8-32 screws. 
 
8) With power to the P4500 "off", install the P4500 power supply 

cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector will mate with the connector on the M4500 only one 
way). 

 
9) Install the respective field wiring arms on all the I/O boards of the 

M4500 (I/O slots0 thru 2, resolver connector, and IN0/IN1 
connector). Make sure all field-wiring connectors are fully mated 
to the M4500. 

 
 
________________________________________________________ 
2.9.2 P4500 POWER SUPPLY INSTALLATION 
 
To install the P4500, perform the following steps: 
 
1) Mount the P4500 to the HSL-CUP4 in the mounting holes next to 

the M4500 (left side) using two 8-32 screws. 
 
2) With power to the P4500 "off", install the P4500 power supply 

cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector will mate with the connector on the M4500 only one 
way). 

 
 
________________________________________________________ 
2.9.3 D4591 KEYPAD/DISPLAY INSTALLATION 
 
To install the D4591, perform the following steps: 
 
1) With the gasket installed on the mounting studs of the D4591, 

install the D4591 in the cut-out of existing control cabinet. Secure 
the display to the enclosure using 7ea. 8-32 nuts and external lock 
washers. 

 
2) Connect the display ribbon cable to the connector on the lower 

back of the display. 
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________________________________________________________ 
2.9.4 DOWNLOAD HSLCUP4 PROGRAM AND SET-UP 
DATA TO M4500 
 
Once the M4500/P4500/D4591 are installed, perform the following to 
download the application program as well as the previously saved set-
up data and timing channel set-points: 
 
1) Power up the M4500 and the PC used to interface with the HSL-

CUP4. 
 
2) Connect an RS-232 cable from the computer COM port to the 

"PROG" port on the M4500. 
 
3) Initiate the respective setup program (HSMCUP7 for Windows 

systems, HSLCUP4.exe for DOS systems). 
 
4) Download the HSLCUP4 application program to the M4500. See 

section 4.2.3 for Windows based systems, see section 5.4 for 
DOS. 

 
5) Download the PLS timing set-points to the M4500. See section 

4.2.4 for Windows based systems, section 5.2 for DOS.  
 
6) Download the previously saved set-up data to the M4500. See 

section 4.2.4 for Windows based systems, section 5.5 for DOS. 
 
7) The M4500 is now ready to run, loaded with HSLCUP4 

application program, timing set-points, and set-up data. 
 
Note:  Double check the machine zero position and re-zero the 
resolver if necessary, prior to running the machine. 
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The keypad of the HSL-CUP4 contains 24 keys consisting of data 
display commands, set-up commands, and a numeric keypad. The 
display of the HSL-CUP4 is a 2 line by 40 character back-lit LCD 
display which displays the selected data and set-up menus. The 
keypad/display can be used by the operator to view data or can be 
used to adjust the timing and all set-up parameters. 
 
 

 
 
The display/keypad allows the following to be viewed or adjusted: 
 

1)  Set the Cupper Set-Up Parameters 
2)  Set the Lubricator Set-Up Parameters 
3)  Set Machine Timing 
4)  Set Machine Zero 
5)  View the Actual Brake Response (in degrees) 
6)  View the Current Shift Data 
7)  View the Last Shift Data 

 
The definitions of the keypad commands and menus are described in 
the following sections.  
 
Note: For virtually all the menus, the “NEXT” and “PREV” keys can 
be used to advance to the next item of the menu or retard to the 
previous item on the menu. To change a set-up parameter, simply 
enter the new value on the numeric keypad and press <ENTER>. The 
value will be entered and the next parameter will automatically be 
displayed. When the last parameter is entered, the primary set-up 
menu will be displayed. Pressing <ESC> at anytime will also exit you 
back to the primary set-up menu. 
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________________________________________________________ 
3.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) 
contains the following data: 
 

MACHINE SPEED (SPM):xxxx   POSITION:xxx 
STROKES:xxxxxxx        DIE JAMS:xxxxxx 

 
• The “Machine Speed” is the Current Speed of the Cupper (in 

strokes per minute) 
• The “Position” is the Current Angular Position of the Cupper 

Crankshaft (in degrees) 
• The “Strokes” Field is the Total Number of Strokes (so far into the 

current shift) 
• The “Die Jams” Field is the Total Number of Die Jams or Cup 

Jams for All Stations (so far into the current shift) 
 
This display effectively replaces a speed meter, a position display, and 
two counters. This screen is always returned to when no commands 
are active. 
 
 
________________________________________________________ 
3.2 “BRAKE RESPONSE” KEY 
 
This displays the brake response for both “Low” and “High” speed 
stops. The response is the number of degrees it takes the press to stop 
from when the clutch is de-activated for a TDC stop to the position 
that the machine comes to rest. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. To exit back to the default screen, simply press the “ESC” 
key. 
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________________________________________________________ 
3.3 “CURRENT SHIFT” KEY 
 
The Current shift menu displays:  
• The Number of “Die Jams/Cup Jams” Per Station for the Current 

Shift 
 
This can be used to help trouble shoot a die problem on a particular 
station by observing an excessive number of die jams or cup jams for 
that station.  
 
Note: The Current shift “Stroke Count” and “Total Die Jams” is 
displayed as part of the default screen (see section 3.1). 
 
 
________________________________________________________ 
3.4 “LAST SHIFT” KEY 
 
The Last shift data menu displays:  
• The “Total Stroke” Count 
• The “Total Die Jams/Cup Jams” Fault Counts Per Station  
 
This data is the totals for the last (previous) shift. This is transferred 
from the current shift when the end of shift input transitions from a 
“0” to a “1”. This can be at the end of either an 8 or 12 hour shift. 
This data cannot be reset by the operator, only at the end of shift 
transition. 
 
The Last shift data is defined as follows: 
 
Strokes: This is the total number of strokes made for the previous 
shift. This is essentially a  counter. 
 
Die Jams: This is the total number of die jam or cup jam faults that 
occurred for all stations on the previous shift. 
 
Die Jams/Cup Jams per Station: This is the number of die jam 
or cup jam faults that occurred on each station on the previous shift. 
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________________________________________________________ 
3.5 “SET-UP” KEY 
 
This selection is used to invoke the primary set-up menu. This 
consists of the following four selections: 
 

1: SET CUPPER PARAMETERS 
2: SET LUBRICATOR PARAMETERS 
3: SET MACHINE TIMING (SET-POINTS, ETC.) 
4: ZERO MACHINE (SET RESOLVER OFFSET) 

 
When selected, each of the above selections will bring up a sub-menu 
with the corresponding set-up parameters. The following sections 
describe these sub-menus and the definitions of the corresponding 
variables. To select the respective set-up sub-menu, simply press the 
corresponding numeric key (1 thru 4). 
 
Note: The primary set-up menu is passcode protected. When the set-
up key is first depressed, an “ENTER PASSCODE:” prompt is 
displayed. At this point, a 5-digit passcode must be entered followed 
by pressing the <ENTER> key. If the passcode is correct, the primary 
set-up menu is displayed and any of the parameters accessed by this 
menu may be changed. If the passcode is incorrect, the message 
“INCORRECT PASSCODE” will be displayed. The passcode may be 
entered again or the <ESC> key can be pressed to return to the main 
menu. 
 
When the passcode is entered, the digits entered are not displayed. 
Instead “*” characters are displayed as each digit is entered. This 
prevents observation of the passcode as it is entered. In addition, the 
“ENTER PASSCODE” prompt is only displayed for a maximum of 
60 seconds. The correct passcode must be entered within a 60 second 
period otherwise the set-up mode is aborted and the main menu is 
displayed. 
 
Refer to section 3.6 (Set Keypad/Display passcode) for details on 
setting the passcode as desired. 
 
A keyed switch can then be wired to the “Set-Up Enable” input such 
that when the switch is in the enable position, the input is “on”. When 
this input is “on”, the passcode prompt is bypassed and access to the 
primary set-up menu is provided immediately. If the “Set-Up Enable” 
input is “off”, then the normal passcode prompt is displayed.  
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________________________________________________________ 
3.5.1 SET CUPPER PARAMETERS 
 
This menu is activated when the “1” key (SET CUPPER 
PARAMETERS) is pressed while the primary set-up menu is active. 
The following set-up parameters may then be adjusted or viewed: 
 
Brake Wear Comp Enable? (0=No, 1=Yes): This prompt is 
used to enable or disable the brake wear compensation. If the 
compensation is to be disabled, enter “0” and press <ENTER>. If the 
compensation is to be enabled, enter “1” and press <ENTER>. 
 
Desired TDC Stop POS (Mid Speed): This is the desired 
stopping location (in degrees) for a TDC stop in mid speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Top Dead Center). This prompt is only displayed when the brake 
wear compensation is enabled. 
 
Desired TDC Stop POS (High Speed): This is the desired 
stopping location (in degrees) for a TDC stop in high speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Top Dead Center). This prompt is only displayed when the brake 
wear compensation is enabled. 
 
Maximum Allowed Stopping Response: This defines what the 
maximum allowed brake response is before the “Brake Response Too 
Long” alarm is generated. If the actual brake response (number of 
degrees from when the brake is activated to the position where the 
press ends up at rest) when a TDC stop is performed is longer than 
this number, the alarm is generated. If the actual brake response is 
less, the alarm is not generated. Set this parameter to the value where 
the brake response is considered too long and service to the brake 
should be performed (typically 270 to 300 degrees). 
 
Running Cupper Low Speed (SPM): This is the speed the 
cupper will run when in low speed. 
 
Running Cupper High Speed (SPM): This is the speed (in 
strokes per minute) that the cupper will run when in high speed. 
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________________________________________________________ 
3.5.2 SET LUBRICATOR PARAMETERS 
 
This menu is activated when the “2” key (SET LUBRICATOR 
PARAMETERS) is pressed while the primary set-up menu is active. 
The following lubricator set-up parameters may then be adjusted or 
viewed: 
 
Lubricator Maximum Speed (SPM): The “Lubricator Maximum 
Speed” parameter is used to scale the 0-10VDC analog output such 
that when the cupper is running at the speed entered in “Lubricator 
Maximum Speed”, the analog output will be at 10 volts. This is 
typically set to the running high speed of the Cupper or slightly 
higher. 
 
Lubricator Minimum Speed (SPM): This parameter determines 
the speed the lubricator will run at when the cupper is stopped (de-
clutched).  
 
Note: When the cupper is running, the lubricator speed reference is 
proportional (as set by the “Lubricator Maximum Speed” scaling) to 
the speed of the cupper. This parameter is used to provide the speed 
reference when the cupper speed is zero (for lubricator jog, etc.). 
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________________________________________________________ 
3.5.3 SET MACHINE TIMING (SET-POINTS, ETC.) 
 
This selection brings up the timing set-point menu which displays the 
following fields: 
 

CHuu  SETPOINT:xxx   []  “channel name” 
RPM:yyyy    POS:zzz     OFFSET:wwww  SCALE:360 

 
Each field is defined as follows: 
 
Field Definition 
Chuu Currently selected channel (CH00 thru CH17) 

where “uu” is the octal channel number. 
 
SETPOINT:xxx Channel “on” or “off” set-point where “xxx” is 

the set-point position 
 
[] State of channel set-point (blank = “off”, solid 

block character = “on”) 
 
“channel name” selected channel name: (CH00) TDC (HIGH) 

TIMING, (CH01) TDC (LOW) TIMING, etc. 
 
RPM:yyyy Current machine speed where “yyyy” is in SPM. 
 
POS:zzz Current resolver position where “zzz” is in 

degrees. 
 
OFFSET:wwww Resolver offset where “wwww” is the offset in 

degrees. 
 
SCALE:360 Resolver SCALE FACTOR (360 degrees per 

revolution). 
 
 
In addition to displaying the timing set-point menu, the following keys 
are also enabled: “ENTER SET-POINT”, “CLEAR CHANNEL”, 
“SELECT CHANNEL”, and “SEARCH CHANNEL”. 
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The “ENTER SET-POINT” key is used to enter a new set-point (both 
“on” and “off” set-points) in the selected channel. The “CLEAR 
CHANNEL” key is used to clear all set-points from the selected 
channel. The “SELECT CHANNEL” key is used to select a new 
channel for programming. The “SEARCH CHANNEL” is used to 
view both the “on” and “off” set-points in the selected channel. 
 
Searching Channel: To view the set-points in a channel simply 
press the “SEARCH CHANNEL” key. The next “off” to “on” or “on” 
to “off” position is shown in the “SETPOINT” field. If the transition 
was “off” to “on”, the state character [] will be a solid block. If the 
transition was “on” to “off”, the state character [] will be blank. 
 
Entering or Adjusting Set-point: To set or adjust a timing 
channel, perform the following: 
1) Select the channel to be adjusted by pressing the “SELECT 

CHANNEL” key, entering the channel number (00 to 17) and 
pressing <ENTER>. In addition, the “NEXT” and “PREV” keys 
can be used to advance to the next channel or retard to the 
previous channel. 

 
2) Press “CLEAR CHANNEL” to clear the existing set-point out. 
 

Note: Entering a new set-point does not automatically clear the 
old set-point out. If the two set-points are not in the same place, 
the channel will simply have two set-points in it if the old one is 
not cleared out first. Therefore, always clear the channel before 
entering a new set-point. A set-point, however, may be “extended” 
by programming another set-point onto an existing set-point using 
either the existing “on” or “off” set-point as the starting position 
for the new set-point. This will result in one larger set-point. 

 
3) Press “ENTER SET-POINT” to enter the new set-point. The 

display will then prompt “ON SETPOINT:”. Enter the position (in 
degrees) where the set-point should go “on” and press <ENTER>. 
The display will now prompt “OFF SETPOINT:”. Enter the 
position (in degrees) where the set-point should go “off” and press 
<ENTER>. The channel will now be programmed with a set-point 
that goes “on” at the “on” position entered and “off” at the “off” 
position entered. 

 
4) Exit back to the primary set-up menu by pressing <ESC>. Exit 

back to the default screen by pressing <ESC> again. 
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________________________________________________________ 
3.5.4 ZERO MACHINE (SET RESOLVER OFFSET) 
 
This selection is used to auto zero the resolver. To set the machine 
zero (resolver offset) perform the following: 
 
1) Select “3: SET MACHINE TIMING” and observe the “POS:” 

field. Verify that as the machine is rotated forward (either inched 
or barred) that the position increases linearly from 0 through 359. 
If not, swap the S1 and S3 leads of the resolver at the HSL-CUP4 
resolver connector. Then verify that the position then indeed does 
increase with forward movement. Press <ESC> to exit back to the 
primary set-up menu. 

 
2) Position the machine at machine zero (top dead center). 
 
3) Auto zero the resolver by selecting “4: ZERO MACHINE” from 

the primary set-up menu. Enter “0” to zero the resolver. The 
timing set-up menu will be displayed, now showing the “POS:” at 
zero. 

 
4) The M4500 will calculate the actual offset value required to make 

this the 000 position and will display this number in the offset 
field. 

 
5) Exit back to the primary set-up menu by pressing <ESC>. Exit 

back to the default screen by pressing <ESC> again. 
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________________________________________________________ 
3.6 SET KEYPAD/DISPLAY “SET-UP” PASSCODE 
 
The “Set Passcode” input to the HSL-CUP4 is used to set or view the 
passcode of the set-up menu. Normally this input should be “off”. To 
set the passcode, jumper this input to +24VDC and press the “Set-Up” 
key. The “ENTER PASSCODE” prompt will be displayed along with 
the current passcode. This allows the passcode to be viewed. 
 
To change the passcode, enter any number between 0 and 64999 and 
press <ENTER>.  
 
Note: Set the passcode to “0” to disable passcode protection. When 
prompted for the passcode, press <ENTER> to proceed to the set-up 
menu. If the passcode protection is used, set the passcode to a number 
between 1 and 64999. A valid passcode will then have to be entered to 
gain access to the set-up menu. Once the passcode is set, turn the “Set 
Passcode” input “off”. 
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The Windows based set-up program is menu driven, allowing the user 
to easily view data, alter set-up variables or set machine timing 
(resolver offset, timing signal locations, etc.), using a PC running the 
Windows (95/98/ME/2000/XP/NT) operating system. The set-up 
variables are used to configure and tune the M4500 to match the 
configuration and performance of the specific cupper (see HSL-CUP4 
Set-up, section 2.8). 
 
Note:  The set-up program is an on-line communications program 
used to interface with the M4500 module.  The data displayed and set 
in the windows is communicated directly to the module, while in the 
“Online” edit mode. Therefore, prior to going online with the 
processor, make sure an RS-232 cable is connected from the COM 
port on the computer to the "PROG" port on the M4500.  The 
variables displayed while in the “Online” edit mode are read directly 
from the processor.  Data is saved to a “Set-up Data” file (*.sdt) 
whenever changes are made to a parameter or if the data is uploaded 
from the processor. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Set-up Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current set-up program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to 
make changes while “Online” with the processor.  The “Offline” 
mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed from the “Edit” menu. 
 
Getting Help:  The entire user’s manual is contained within the help 
file.  Pressing Ctrl+H will display the help file window.  Pressing the 
F1 key will display the contents file.  Hot spots allow jumps to other 
topics to display additional information as desired.  Selecting “About 
HSMCUP7” from the Help menu will display a dialog box listing 
information about the current revision of the setup program and how 
to obtain technical support. 
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________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to the 

processor 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________ 
4.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the set-up program is first invoked, the 
default set-up parameters are loaded into memory.  If changes are 
made to any of the set-up parameters (either online or offline), as well 
as shift data, the user will be flagged to “Save Changes” upon exit of 
the program. 
 
Note:  Any windows based “Set-up” program can open a set-up 
“Data File”, however, the data tables will not be properly aligned.  
The user will be alerted to the problem if a set-up data file has been 
created by either a different set-up program or a different revision of 
the software. 
 
The set-up “Data File” is similar to that of a word processing file.  
When the program first starts, a default file is loaded and the user is 
able to make any changes as desired.  The set-up program is unaware 
of the settings and parameters that exist within the M4500.  Therefore, 
to normalize the set-up program with the processor, the user should 
define or open an existing file, then upload “All” variables from the 
processor.  This allows the user to either create a backup of the data or 
maintain an existing file.  The user can even open a data file for 
another cupper, save the file to a new name, make the necessary 
changes and simply download the new parameters to another 
processor. 
 
The following functions can be accessed any time, from any set-up or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes to the existing file. 
 
Open:  To “Open” and existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box allowing 
the user to select an existing data file to open. The name of the file 
will be displayed in the title bar.  If any changes were made to the 
existing file, the user will be prompted to save any changes before 
terminating the program. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  This displays a dialog box allowing the 
user to select a folder and enter a name for the file.  The user will be 
notified if the file already exists and the extension “.sdt” will 
automatically be added to the file name.  If this is a “New” file, the 
user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box allowing the user to 
select a folder and enter in a new name for the file.  The user will be 
notified if the file exists and the extension “.sdt” will automatically be 
added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
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________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload set-up parameters, 
timing channel set-points and shift data from the M4500 into a set-up 
“Data File”.  This function is accessed from the “File” menu and the 
user is given the choice of the following options: 
 

 
 
Set-up Parameters:  This option uploads the “Set-up” data from 
the M4500.  This includes cupper and lubrication set-up parameters. 
 
Timing Channels:  This option uploads the “Machine Timing” 
channel set-points, as well as, the PLS configuration and scale factor. 
 
Shift Data:  This option uploads the “Shift Data” from the M4500.  
This includes the total strokes, total die jams and die jams per station 
for both the current and last shifts. 
 
All:  This option allows the user to completely upload “All” of the 
set-up parameters, timing channel set-points and shift data from the 
M4500. 
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________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev 
program file to the M4500. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the set-up program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid M4500 PLC SYSdev 
file can be downloaded through the set-up program.  Care should be 
taken when selecting a program to download. 
 



SECTION 4 
HSMCUP7 WINDOWS BASED 
SET-UP PROGRAM REFERENCE 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 44 - 

Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.  The user must 
confirm their selection by clicking the “Yes” command button.  After 
the user confirms their choice, program download is initiated and the 
current program download address is displayed.  When program 
download is complete, the user is prompted to acknowledge.  Control 
is passed back to the main program and the set-up program remains in 
an “Online” edit mode. 
 
 
________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” parameters, 
timing channel set-points and shift data to the M4500 from the set-up 
“Data File”.  This function is accessed from the “File” menu and the 
user is given the choice of the following options: 
 

 
 
Set-up Parameters:  This option downloads the “Set-up” data to 
the M4500.  This includes cupper and lubrication set-up parameters. 
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Timing Channels:  This option downloads the “Machine Timing” 
channel set-points, as well as the PLS configuration and scale factor to 
the M4500 PLS. 
 
Shift Data:  This option downloads the “Shift Data” to the M4500.  
This includes the total strokes, total die jams and die jams per station 
for both the current and last shifts. 
 
All:  This option allows the user to completely download “All” of the 
set-up parameters, timing channel set-points and shift data to the 
M4500. 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
 
________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout 
of all the set-up parameters, timing channel set-points and shift data.  
This function is accessed from the “File” menu. 
 
At the top of each page, the report displays the name of the set-up file 
being printed.  At the bottom of each page is the date and time the 
document was printed, as well as, the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  

This displays the “Print Setup” dialog box, allowing the user to 
select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the 
specified printer device.  This function makes use of the windows 
print manager, which allows the user to continue with their work 
while the document is being printed. 
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________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Set-up the Comm Port. 
• Set the Set-up Passcode 
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________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded set-up data file.  This allows the user the ability to 
make any necessary changes to the set-up parameters while not online 
with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-
up parameters and shift data.  When the program is first invoked, the 
default setting is offline editing disabled.  The user will need to 
specifically select “Enable Offline Editing” from the edit menu (or 
press function key F2) to enable/disable this feature. 
 
 
________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications 
port and baud rate to talk to the M4500.  The programming port of the 
M4500 is set to 9600 baud.   
 

 
 
Once selected, a dialog box requesting the user to select a “Comm 
Port” and “Baud Rate” will be displayed.  The default setting is 
COM1 at 9600 baud.  The option to select the 19200 baud rate is to 
allow the user to communicate with the processor via the S4516 serial 
communications board. 
 
In most cases the user will only need to specify the communications 
port and leave the baud rate at 9600.  If communication problems 
occur, make sure there is a secure connection from the PC to the PLC.  
Then check the Comm port.  In most cases the user will only need to 
select a new Comm port.  If communication problems persist, there 
may be another program causing a conflict with the port.  Check the 
port configuration from the “Settings” folder. 
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________________________________________________________ 
4.3.3 EDIT SET-UP PASSCODE 
 
The edit “Set-up Passcode” is an “Online” function only.  This allows 
the user the ability to directly change the value of the “Set-up 
Passcode”.  The passcode is not included as part of the setup data file. 
 
Once selected, an input box is displayed, allowing the user to view the 
current “Passcode” setting and to change the value if necessary.  If the 
passcode is set to zero, passcode entry is disabled.  The operator can 
press the Set-up key on the Keypad/Display and simply press the 
<ENTER> key to gain access to the set-up parameters without having 
to enter a zero.  
 
If the value of the passcode is a value between 1 and 65,000, 
“Passcode Entry” is enabled.  This requires the operator to enter in the 
“Correct” passcode to gain access to the set-up parameters. 
 
Note:  Passcode entry is only in effect when the “Set-up Enable” 
selector switch is in the “Disable” position. 
 
If an invalid value is entered, the passcode value will not be reset and 
a message box notifying the user of the error is displayed. 
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the set-up program will prompt the user to select a 
program to compare with the one existing in the processor.  Whether a 
program is selected or the user cancels, the setup program will attempt 
to communicate with the M4500.  If unsuccessful, a warning message 
will be displayed, prompting the user to either “Retry” or “Cancel” the 
operation.  If the operation is canceled and communication with the 
processor cannot be established the system will be placed in an 
“Offline” mode, however the “Target Board Interface” window will 
still be displayed. 
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________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an 
“Online” mode with the processor.  This is accessed by the “View” 
menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm port 
and communicate with the M4500.  If the set-up program is 
unsuccessful, a warning message will be displayed prompting the user 
to either “Retry” or “Cancel” the operation.  If the operation is 
canceled and communication with the processor cannot be established 
the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed, prompting the user to either “Retry” or “Cancel” the 
operation. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an 
“Offline” mode.  This is accessed by the “View” menu, by selecting 
“Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in 
“Offline” edit mode reflect the actual values contained in the currently 
loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease 
communication with the M4500. 



SECTION 4 
HSMCUP7 WINDOWS BASED 
SET-UP PROGRAM REFERENCE 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 52 - 

________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of 6 different 
Display/Set-up windows to modify set-up parameters, view shift data 
or receive feedback about the current status of the control system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item and the selected window is displayed with the name 
changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the 
control system.  This window is selected from the “Window”. 
 

 
 
The following is a list of the functions of the “Main Display” window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4500, as well as, 
the current “Online” or “Offline” status of the set-up program.  By 
simply scrolling the display, the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine Speed:  This display is only active while “Online” and 
displays the current speed of the machine in “Strokes Per Minute”. 
 
Position:  This display is only active while “Online” and displays 
the current angular position of the cupper crankshaft. 
 
Strokes:  This display is the “Current Shift” total number of strokes 
into the current shift.   
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Die Jams:  This display is the “Current Shift” total number of die 
jams or cup jams for all stations that the machine has had so far into 
the current shift 
 
Brake Response:  This is the brake response of both the low and 
high-speed stops.  The response is the number of degrees it takes the 
press to stop from when the clutch is de-activated for a TDC stop to 
the position that the machine comes to rest. 
 
 
________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Set-up Parameters” window is used to view and adjust any of the 
set-up parameters.  This window is selected from the “Window” 
menu. 
 

 
 
This window utilizes a “TAB” control to divide the set-up parameters 
into two categories, similar to that of the Keypad/Display. 
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Brake Wear Compensation:  This section is used to set the brake 
wear compensation parameters in the M4500.  This section contains 
the following selections: 
 
1) Brake Wear Compensation Enable: This prompt is used to 

enable or disable the brake wear compensation. If the 
compensation is to be disabled, deselect the check box. If the 
compensation is to be enabled, select the check box. 

 
 The HSL-CUP4 incorporates a brake wear compensation or 

automatic TDC timing feature, which stops the press at TDC 
regardless of the actual braking response of the clutch/brake. The 
stopping compensation is accomplished by automatically adjusting 
the TDC timing signal based on the previous stop. Any overrun is 
detected and a new TDC timing signal is computed such that the 
machine will stop at the desired location on the next stop. Three 
TDC signals are provided: one for low speed, one for mid speed, 
and one for high speed. The mid and high speed TDCs incorporate 
the break wear compensation feature. The appropriate TDC timing 
signal (mid or high) is adjusted based on the speed of the machine 
when the TDC stop was initiated. 

 
2) Desired TDC Stop Position (Low Speed): This is the 

desired stopping location (in degrees) for a TDC stop at low speed 
when the brake wear compensation is enabled. This is typical set 
to 000 degrees (Back Dead Center). 

 
3) Desired TDC Stop Position (High Speed): This is the 

desired stopping location (in degrees) for a TDC stop in high 
speed when the brake wear compensation is enabled. This is 
typical set to 000 degrees (Back Dead Center). 

 
4) Maximum Allowed Stopping Response (degrees): This 

defines what the maximum allowed brake response is before the 
"Brake Response Too Long" alarm is generated. If the actual brake 
response (number of degrees from when the brake is activated to 
the position where the press ends up at rest) when a TDC stop is 
performed is longer than this number, the alarm is generated. If 
the actual brake response is less, the alarm is not generated. Set 
this parameter to the value where the brake response is considered 
too long and service to the brake should be performed (typically 
270 to 300 degrees). 
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Cupper Running Speeds:  This section is used to set the cupper 
running speeds in the M4500.  This section contains the following 
selections: 
 
1) Running Cupper Low Speed (SPM): This is the speed (in 

strokes per minute) the cupper will run when in low speed. 
 
2) Running Cupper High Speed (SPM): This is the speed (in 

strokes per minute) the cupper will run when in high speed. 
 
 
Lubricator Parameters:  This section is used to set the lubricator 
speed references in the M4500.  This section contains the following 
selections: 
 

 
 
1) Lubricator Maximum Speed (SPM): The "Lubricator 

Maximum Speed" parameter is used to scale the 0-10VDC analog 
output such that when the cupper is running at the speed entered in 
"Lubricator Maximum Speed", the analog output will be at 10 
volts. This is typically set to the running high speed of the Cupper 
or slightly higher. 

 
2) Lubricator Idle Speed (SPM): This parameter determines the 

speed the lubricator will run at when the cupper is stopped (de-
clutched). 
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________________________________________________________ 
4.5.3 THE SERIAL COMMUNICATIONS WINDOW 
 
The Serial Communications window is used to view the configuration 
status of the S4516 serial communications board (if installed), as well 
as, view the status of the Allen-Bradley DF1 communication protocol 
and set-up the Allen-Bradley PLC communication parameters.  From 
this window the user can view or adjust the following parameters: 
 
• View the S4516 configuration status. 
• View the S4516-DF1 serial communication status. 
• View the Allen-Bradley Link Layer serial communication status. 
• Select the Allen-Bradley PLC type (PLC5 or SLC500) to 

communicate with. 
• View/Set the Allen-Bradley PLC destination node. 
• Select the starting Allen-Bradley PLC destination file number. 
 

 
 
S4516 Configuration Status:  This displays the current state of 
the configuration of the S4516 serial communications board.  System 
function sfunc19(); (S4516 configuration) is used to set the S4516 
configuration (network node address, network baud rate and USER 
port baud rate).  This must be executed prior to executing ether system 
functions 10, 11 or 13.  System function 19 is generally executed in 
the “Initialization” file of the user program. 
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The following values are returned from a system function 19 call: 
 1 = Busy. 
 2 = Done (S4516 Successfully configured). 
 3 = Invalid Parameter (either network node address, network baud 

rate or USER port baud rate is invalid). 
 4 = Timeout (no response form S4516) 
 32 = Hardware ACK error from S4516 
 34 = Invalid S4516 Slot Address (W8156 must be loaded with the 

slot address of the S4516, prior to executing system function 
19). 

 
Transmit Data Status:  This represents the state of the data packet 
transmission. This will typically display either “Busy” or “Done”.  If 
there are problems delivering the message packet, the response code, 
along with a description, will be displayed. 
 
Note:  The “Transmit Data Status (prev.)” is used to view the last or 
previous status. 
 
Current Transaction:  This is the “Transaction” number delivered 
to the Allen-Bradley PLC. 
 
Active Command:  This displays either “Read” or “Write”.  This is 
used to view the command type of the current transaction. 
 
Number of BYTES Received:  This displays the current number 
of bytes received from either a “Command” or “Reply” message 
packet. 
 
Received Command BIT Status:  This displays the state of the 
command received.  If this displays a “Reply”, then the command was 
sent from the M4500.  If this displays “Command”, then a command 
action was received by the M4500. 
 
A/B Link Layer Status:  This displays the status of the receipt of 
the message packet sent to the Allen-Bradley PLC.  If the delivery is 
not successful, an error code along with a description is displayed.  
Refer the to the Allen-Bradley Communication Protocol and 
Command Set reference manual for more information on “Link 
Layer” error codes. 
 
A/B Link Layer – Current Transaction Received:  This is the 
“Transaction” number received from the Allen-Bradley PLC. 
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PLC Type:  This is used to specify the “Type” of PLC the M4500 
will communicate to.  The user can choose from “PLC5” or 
“SLC500”. 
 
Note:  This parameter should be set prior to communicating with an 
A/B processor. 
 
Destination Node:  This is used to set the node number of the A/B 
PLC to send and receive data from.  This also displays the node 
number of the A/B PLC that sent a “Command” message packet. 
 
Destination File Number:  This is the file number the M4500 will 
read and write data from.  See Appendix B for a description of the 
data read from and written to an Allen-Bradley PLC. 
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________________________________________________________ 
4.5.4 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming 
command menus.  From this window, the user can view or adjust the 
following parameters: 
 
• Adjust Timing Channel setpoints. 
• Set the resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
 

 
 
In addition, the following parameters are displayed at the bottom of 
this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the 
resolver. 
 
Position:  This is the current “Position” in degrees of the resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
 
Scale:  This is the scale factor of the resolver or the number of 
divisions in one revolution. 
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Note:  The General Timing Signal Locations section provides a 
complete description of each timing channel signal. 
 
 
Zeroing the Machine (setting the resolver offset):  To set 
machine zero, perform the following: 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4500.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and place 
the system into an “Online” mode of operation. 

 
4) Observe the “Position” field at the bottom of the window.  Verify 

that as the machine is rotated forward, that the position increases 
linearly from 0 through 359 degrees.  If not, swap the S1 and S3 
leads at the resolver connector on the M4500.  Then, verify that 
the position does indeed increase with forward movement. 

 
5) Position the machine at machine zero (inch the cupper to top dead 

center TDC). 
 
6) Auto zero the resolver by entering “0” in the “Resolver Offset” 

field and clicking the “Set Offset” command button.  A message 
box will appear, prompting the user to confirm their choice.  
Select “Yes” to set the resolver offset. 

 
7) The M4500 will calculate the actual offset value required to make 

this the “0” position.  The new offset value will be displayed in 
the “Offset” field and the position will then read zero. 
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Adjusting the Timing Channel Setpoints:  To set any of the 
timing signal setpoints, perform the following: 
 
Note:  Any changes made to the timing channel setpoints will be 
saved as part of the setup data file. 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4510.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and place 
the system into an “Online” mode of operation. 

 
4) Set all channels per the General Timing Signal Locations section.  

Setpoints for a particular channel are either entered in the field or 
adjusted by using the increment/decrement controls. 

 
Note:  Only one set-point is used per channel.  

 
5) If a channel needs to be “Recalled” or “Cleared”, enter the desired 

channel number into the “PLS Channel” field.  Click the “Recall 
Channel” command button to recall the setpoints.  Click the 
“Clear Channel” command button the completely clear all 
setpoints for the selected channel. 

  
 Note:  If a channel has been cleared or the “On” and “Off” 

setpoints have the same setting, the set-point will be displayed as 
“*****”. 
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Resetting the PLS Configuration:  As an aid to the user the 
current PLS configuration is displayed in the “PLS Configuration” tab 
of this window.  The PLS configuration should only be reset if a new 
module has been installed.  To reset the PLS configuration, click the 
“Reset PLS Config” command button.  This function only resets the 
PLS configuration to the default settings. 
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________________________________________________________ 
4.5.5 THE SHIFT DATA WINDOW 
 
The “Shift Data” window is used to view the shift data collected by 
the M4500.  This window is selected from the “Window” menu. 
 

 
 
This window utilizes a “TAB” control to divide the set-up parameters 
into two categories, similar to that of the Keypad/Display.  These 
sections are as follows: 
 
Current Shift Data:  This section is used to view the “Current 
Shift” data.  This data is the totals so far into the shift.  This data is 
transferred to the "Last shift" at the end of either an 8 or 12 hour shift 
or alternatively could be done at label changes such that the data 
collected would be for label runs rather than complete shifts.  This 
data can be reset by the user from this section. 
 
Note:  The “Transfer Data” command button is only active while 
“Online”.   
 
1) Strokes: This is the total number of strokes made for the shift. 

This is essentially a counter. 
 
2) Die Jams: This is the total number of die jam or cup jam faults 

that occurred for all stations on the shift. 
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3) Die Jams/Cup Jams per Station: This is the number of die 
jam or cup jam faults that occurred on each station on the shift. 

 
 
Last Shift Data:  The "Last Shift" data is identical to the current 
shift data except it is for the previous 8 or 12 hour shift or previous 
label run, however the shift collection is set-up.  This allows data 
collection and diagnostics to take place automatically over a two shift 
period. 
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________________________________________________________ 
4.5.6 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs 
and outputs.  The control boards, the states of the timing channels, as 
well as states of the M4500 are shown.  This includes the interrupt 
inputs (IN0 and IN1), the analog I/O and the resolver.  These values 
are displayed as read by the M4500 processor. 
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The DOS based “HSLCUP4” set-up program is menu driven program, 
allowing the user to easily view data or alter set-up variables using a 
laptop or personal computer. In addition to setting the set-up 
variables, it can be used to download the application program to the 
module as well as download and up-load the set-up data and save it to 
disk. The set-up variables are used to configure and tune the HSL-
CUP4 to match the configuration and performance of the specific 
cupper (see section 2.8). 
 
The main menu of the “HSLCUP4” set-up program incorporates the 
following menu selections: 
 

 
 
Note: The “HSLCUP4” program is an on-line communications 
program used to interface with the M4500 module. The data displayed 
in the menus and set in the menus is communicated directly to the 
module. Therefore, prior to selecting any of the above selections, 
make sure an RS-232 cable is connected from the COM port on the 
computer running “HSLCUP4” to the “PROG” port on the M4500. 
 
The following sections are a complete description of the “HSLCUP4” 
selections and menus. 
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________________________________________________________ 
5.1 SET CUPPER/LUBRICATOR SET-UP PARAMETERS 
 
This selection is used to set the various set-up parameters in the HSL-
CUP4. When selected, the “Cupper/Lubricator Set-up Parameters” 
menu is invoked.   
 
The “Cupper/Lubricator Set-up Parameters” menu contains the 
following selections: 
 

 
 
The following selections set the corresponding parameters: 
 
 
________________________________________________________ 
5.1.1 ENABLE/DISABLE BRAKE WEAR COMPENSATION 
 
Brake Wear Compensation Enable? (0=No, 1=Yes): This 
prompt is used to enable or disable the brake wear compensation. If 
the compensation is to be disabled, enter “0” and press <ENTER>. If 
the compensation is to be enabled, enter “1” and press <ENTER>. 
 
Desired TDC Stop Position (Mid Speed): This is the desired 
stopping location (in degrees) for a TDC stop in mid speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). 
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Desired TDC Stop Position (High Speed): This is the desired 
stopping location (in degrees) for a TDC stop in high speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). 
 
 
________________________________________________________ 
5.1.2 MAXIMUM ALLOWED STOPPING RESPONSE 
 
Maximum Allowed Stopping Response (degrees): This 
defines what the maximum allowed brake response is before the 
“Brake Response Too Long” alarm is generated. If the actual brake 
response (number of degrees from when the brake is activated to the 
position where the press ends up at rest) when a TDC stop is 
performed is longer than this number, the alarm is generated. If the 
actual brake response is less, the alarm is not generated. Set this 
parameter to the value where the brake response is considered too 
long and service to the brake should be performed (typically 270 to 
300 degrees). 
 
 
________________________________________________________ 
5.1.3 SET CUPPER RUNNING SPEEDS 
 
Running Cupper Low Speed (SPM): This is the speed (in 
strokes per minute) that the cupper will run when in low speed. 
 
Running Cupper High Speed (SPM): This is the speed (in 
strokes per minute) that the cupper will run when in high speed. 
 
 
________________________________________________________ 
5.1.4 SET LUBRICATOR SPEED REFERENCES 
 
Lubricator Maximum Speed (SPM): The “Lubricator Maximum 
Speed” parameter is used to scale the 0-10VDC, analog output such 
that when the cupper is running at the speed entered in “Lubricator 
Maximum Speed”, the analog output will be at 10 volts. This is 
typically set to the running high speed of the Cupper or slightly 
higher. 
 
Lubricator Idle Speed (SPM): This parameter determines the 
speed the lubricator will run at when the cupper is stopped (de-
clutched).  
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Note: When the cupper is running, the lubricator speed reference is 
proportional (as set by the “Lubricator Maximum Speed” scaling) to 
the speed of the cupper. This parameter is used to provide the speed 
reference when the cupper speed is zero. 
 
 
________________________________________________________ 
5.2 SET MACHINE TIMING 
 
The Set Machine Timing selection is used to invoke the PLS 
programming command menus (these are the same menus used in 
SYSdev to program the PLS section of the HSL-CUP4). When 
selected, the PLS programming main development menu will be 
invoked using the default “CUP7TMG” channel set-point file.  
 

 
 
From this menu, the user can zero the machine (set the resolver offset) 
and adjust the timing signal set-points. The following sections 
describe how to perform these functions. Section 6 provides a 
complete description of each timing signal. 
 
Note: Prior to selecting the Machine Timing selection, make sure the 
RS-232 cable is connected from the COM port on the computer to the 
PROG PORT on the HSL-CUP4. 
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________________________________________________________ 
5.2.1 ZERO THE MACHINE 
 
To set the machine zero (resolver offset) perform the following: 
 
1) Select the “2: Set Machine Timing” selection from the HSL-CUP4 

set-up program main menu. 
 
2) Select “1: Online Channel Setpoint Programming” from the Main 

Development menu. 
 

 
 
3) Select “F9: POS/RPM” and observe the “POS:” field. Verify that 

as the machine is rotated forward (either inching or barred) that 
the position increases linearly from 0 through 359. If not, swap the 
S1 and S3 leads of the resolver at the HSL-CUP4 resolver 
connector. Then verify that the position then indeed does increase 
with forward movement. Press <ESC> to exit the “POS/RPM” 
update. 

 
4) Position the machine at Top Dead Center. 
 
5) Auto zero the resolver by selecting “F10: Set Offset”. Enter “0” in 

the offset field and press <ENTER>. The HSL-CUP4 will 
calculate the actual offset value required to make this the 000 
position and will display this number in the offset field. The 
position will now read 0. 
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6) Exit back to the PLS Main Development menu by pressing 
<ESC>. Exit back to the “HSMCUP7” set-up main menu by 
pressing <ESC> again. 

 
 
________________________________________________________ 
5.2.2 ADJUSTING THE TIMING CHANNEL SET-POINTS 
 
To set or alter any of the timing signal set-points, perform the 
following: 
 
1) Select the “2: Set Machine Timing” selection from the HSL-CUP4 

set-up program main menu. 
 
2) Select “1: Online Channel Setpoint Programming” from the Main 

Development menu. 
 
3) Set all channels per section 6. Set-points are entered for a 

particular channel simply by typing in the set-point in the form 
XXX-YYY<ENTER> in the first set-point of the given channel. 

 
Note: Up to 50 set-points may be entered for any channel. 
However, for the cupper only one set-point is used per channel 
and this should be entered in the number 1 set-point.  
 
The XXX is the location the set-point will turn “on” while YYY is 
the location where the set-point will turn “off”. Use the PgUp, 
PgDn, F1:Next Chan, or F2: Prev Chan keys to select the desired 
channel for programming. 

 
4) Once all channels are programmed, press <ESC> to exit back to 

the PLS Main Development Menu. Press <ESC> again to exit 
back to the “HSMCUP7” set-up main menu. The new channels 
will be saved both in the module and in the “CUP7TMG” file on 
the hard drive. 
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________________________________________________________ 
5.3 SHIFT DATA/BRAKE RESPONSE 
 
This selection is used to view the Current Shift data, Last Shift data, 
and the Low and High Speed Brake Responses. When selected, the 
“Shift Data/Brake Response” menu is invoked.   
 
The following data is displayed in the “Shift Data/Brake Response” 
menu: 
 

 
 
Current Shift - Total Strokes: This is the total number of strokes 
made so far into the current shift. This is essentially a stroke counter. 
 
Last Shift - Total Strokes: This is the total number of strokes 
made in the last (previous) shift. This is essentially a stroke counter. 
 
Note: The current shift data is transferred to the “Last shift” data 
when the end of shift input transfers from a “0” to a “1”. This can be 
at the end of either an 8 or 12 hour shift. This data cannot be reset 
either from this menu or by the operator, only at the end of shift 
transition. 
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Mid Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the TDC (Mid) 
timing) to where the cupper crankshaft came to rest when a TDC stop 
was performed at mid speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
High Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the TDC (hi) 
timing) to where the cupper crankshaft came to rest when a TDC stop 
was performed at high speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Note: The brake response of the brake for both high and mid speeds 
is updated after each TDC stop. 
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________________________________________________________ 
5.4 DOWNLOAD PROGRAM TO MODULE 
 
This selection is used to download the HSLCUP4 application program 
to the M4500 module. This should be performed when replacing the 
module or whenever the program has been changed. To download the 
program, perform the following: 
 
Note: Program download cannot be performed while the cupper is 
running. All outputs on the HSL-CUP4 are turned “off” and no 
program execution is performed. The cupper should therefore be 
stopped before the download takes place. 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the “PROG” port on the HSL-CUP4. 
 
2) Select “4: Download Program to Module” from the Main Menu. 

The current program ident, revision, and checksum for both the 
program on disk and already loaded in the module will be 
displayed. A prompt will be displayed asking to continue or abort. 
To continue, press any key except the <ESC> key. To abort, press 
the <ESC> key. If a prompt stating that the “HSLCUP4” file could 
not be opened is displayed, then the “HSLCUP4” application 
program is not installed in the current directory. 

 
3) Once program download is initiated, HSL-CUP4 program 

execution will cease, the current address being downloaded will 
be displayed, and the “RUN” LED on the module will flash 
continuously. 

 
4) Once the download is complete, the “RUN” LED on the module 

will illuminate solid and program execution in the HSL-CUP4 
will resume. Press any key to return to the “HSMCUP7” main 
menu. 

 
5) This selection can also be used to verify the program ident, 

revision, and checksum without downloading the program. 
Perform steps 1 thru 3 above but instead of initiating the 
download in step 3, simply press the <ESC> key to abort the 
download once the ident, revision, and checksum have been 
displayed. 

 



SECTION 5 
HSLCUP4 DOS BASED 
SET-UP PROGRAM REFERENCE 

 
HSL-CUP4 User’s Manual SYSTEMS Electronics Group 

 
- 76 - 

________________________________________________________ 
5.5 DOWNLOAD SET-UP DATA TO MODULE 
 
This selection is used to download the previously uploaded (saved) 
set-up variables to the HSL-CUP4 module. This should only be 
performed when replacing the module.  
 
Note: The set-up data consists of the cupper and lubricator set-up 
parameters. Timing channel set-points are not stored as part of the set-
up data, these are stored in the “CUP7TMG” file. To download the 
set-up data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the “PROG” port on the HSL-CUP4. 
 
2) Select “5: Download Set-up data to Module”. A prompt will be 

displayed asking to continue or abort. To continue, press any key 
except the <ESC> key. To abort, press the <ESC> key. 

 
3) Once data download is initiated, the current address being 

downloaded will be displayed.  
 

Note: Program execution is not ceased therefore data download 
can be performed while the machine is running. 

 
4) Once download is complete, press any key to return to the main 

menu. 
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________________________________________________________ 
5.6 UPLOAD (SAVE) SET-UP DATA FROM MODULE 
 
This selection is used to save the set-up variables from the HSL-CUP4 
module to the hard drive (current directory selected). This should be 
performed anytime any of the set-up variables have been changed.  
 
Note: When the set-up variables are changed, they are changed 
directly in the module, not on the file in the computer. By uploading 
(saving) the set-up variables to disk, they can be downloaded to the 
module in the event the module must be replaced. 
 
The set-up data consists of the cupper and lubricator set-up 
parameters. Timing channel set-points are not stored as part of the set-
up data, these are stored in the “CUP7TMG” file. To upload the set-
up data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the “PROG” port on the HSL-CUP4. 
 
2) Select “6: Upload (Save) Set-up data from Module”. A prompt 

will be displayed asking to continue or abort. To continue, press 
any key except the <ESC> key. To abort, press the <ESC> key. 

 
3) Once data upload is initiated, the current address being uploaded 

will be displayed.  
 

Note: Program execution is not ceased therefore data upload can 
be performed while the machine is running. 

 
4) Once upload is complete, press any key to return to the main 

menu. 
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The following is a general description of the timing signals and the 
locations they should be set at: 
 
 
CH00: TDC (High) Timing: This signal is used to de-activate the 

clutch for a TDC stop at high speed.  
 
 Note: The leading edge is used to de-activate the clutch, 

thus the width of the signal is not critical (generally set 20 
degrees wide). When the brake wear compensation is 
enabled, this signal is adjusted automatically by the HSL-
CUP4. If the brake wear compensation is disabled, this 
signal must be set manually. In this case, it should be set 
such that the press stops at top dead center for a TDC stop at 
high speed. 

 
CH01: TDC (Mid) Timing: Same as the TDC (High) timing 

(CH00) except used when the machine is running in mid 
speed. 

 
CH02: TDC (Low) Timing: Same as the TDC (High) timing 

(CH00) except used when the machine is running in low 
speed. The TDC (Low) timing does not incorporate the 
brake wear compensation feature and must therefore be set 
manually. 

 
CH03: Air Strip (High) Timing: This signal is used to activate 

the air strip solenoid when the machine is running in high 
speed. The air strip is “on” for the entire window that CH03 
is “on” while the machine is running. This signal is generally 
set “on” about 120 degrees and then set “off” at about 200. 

 
CH04: Air Strip (Mid) Timing: Same as the Air Strip (High) 

timing (CH03) except used when the machine is running in 
mid speed. This is generally set “on” about 140 degrees and 
then “off” at about 220. 

 
CH05: Air Strip (Low) Timing: Same as the Air Strip (High) 

timing (CH03) except used when the machine is running in 
low speed. This is generally set “on” about 150 degrees and 
then “off” at about 230. 
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CH06: Cup Drop Window Timing: This signal is used to verify 
that the cups do drop correctly from the die. The cups must 
drop inside this window to avoid a die jam fault and the cups 
must not be detected outside this window in order to avoid a 
cup jam fault. The signal is generally set “on” at 140 degrees 
(or the point where the cups are first freed from the punches) 
and set “off” at 120 degrees (almost one stroke later to allow 
the maximum amount of time for the cups to drop). 

 
CH07: PLC Timing: This is a general purpose timing signal 

provided as an output which can be input to the host PLC 
and used for whatever purpose desired by the host PLC. In 
addition this signal can be used to jumper out un-used die 
stations on machines that are less than 16-out. In this case 
this signal simulates the cup drop for the un-used stations in 
order to avoid a die jam. 

 
CH10: Motion Timing: This is a pulse train set “on” for 30 

degrees and then set “off” for 30 degrees through-out the 
entire channel. 
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The following are recommended spares for the HSL-CUP4. These 
parts are available through Systems Engineering Assoc. Inc. 
 
 
 Quantity Part Number Description 
 
 1ea. M4500 PLC/PLS Processor/Chassis – 4 

Slot 
 1ea. P4500 Power Supply 
 1ea. S4563 16 Point 10-30VDC Input Board 
 1ea. S4568 8 Input/8 Output 10-30VDC I/O 

Board 
 1ea. D4591 Keypad/Display 
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________________________________________________________ 
HARDWARE 
 
DF1 communication takes place via the Channel 0 port of the Allen 
Bradley PLC. The RS-232 cable should be constructed and connected 
as shown below: 
 
S4516-DF1 to PLC5 
 

 
Internally, the PLC-5 should be set up for RS-232C communication. 
Refer to the dip-switch settings guide on the side of the processor. 
 
Note: The S4516-DF1 should be switched for RS-232 
communication.   
 
Dip switch SW1 is the RS-232/RS-422 dip switch should be set to:  
 POLE 1 = ON  
 POLE 2 = OFF 
 
Dip switch SW2 is the slot address, and is dependent upon the rest of 
the cards in the M4500 rack and should be set to: 
 POLE 1 = ON  
 POLE 2 = ON 
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S4516-DF1 to SLC 
 

 
 
S4516-DF1 to ControLogix 
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________________________________________________________ 
SOFTWARE 
 
PLC5 
The following sample RSLogix5 code is used to execute the message 
control function to allow a PLC5 processor to communicate with the 
S4516-DF1 serial communications board. 
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SLC500 
The following sample RSLogix500 code is used to execute the 
message control function to allow a SLC500 processor to 
communicate with the S4516-DF1 serial communications board. 
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ControlLogix and CompactLogix 
The following sample RSLogix5000 code is used to execute the 
message control function to allow a ControLogix or CompactLogix 
processor to communicate with the S4516-DF1 serial communications 
board. 
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________________________________________________________ 
USING THE MSG INSTRUCTION 
 
READ INSTRUCTION – PLC5 
The read message (MSG) command for a PLC5 is setup as follows: 
 

 
 
 
Note:  The Communication Command is “SLC Typed Logical Read”.  
The Data Table Address can be any integer file address.  The 35 
elements (total) read from the M4500 PLC are defined in the last 
section – Read/Write Data Definitions. 
 
The Local Station Address is only necessary to define if 
communications with the S4516-DF1 is executed over a Data 
Highway network (via a DataLink Module). 
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WRITE INSTRUCTION – PLC5 
The write message (MSG) command for a PLC5 is setup as follows: 
 

 
 
 
Note:  The Communication Command is “SLC Typed Logical 
Write”.  The Data Table Address can be any integer file address.  The 
5 elements written to the M4500 PLC are defined in the last section – 
Read/Write Data Definitions. 
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READ INSTRUCTION – SLC500 
The read message (MSG) command for a SLC500 is setup as follows: 
 

 
 
 
 
Note:  The Data Table Address can be any integer file address.  The 
35 elements (total) read from the M4500 PLC are defined in the last 
section – Read/Write Data Definitions. 
 
The Local Station Address is only necessary to define if 
communications with the S4516-DF1 is executed over a Data 
Highway network (via a DataLink Module). 
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WRITE INSTRUCTION – SLC500 
The write message (MSG) command for a SLC500 is setup as 
follows: 
 

 
 
 
Note:  The Data Table Address can be any integer file address.  The 5 
elements written to the M4500 PLC are defined in the last section – 
Read/Write Data Definitions. 
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READ INSTRUCTION CONFIGURATION – CONTROLOGIX 
The read message (MSG) configuration for a ControLogix PLC is 
setup as follows: 
 

 
 
Note:  The “Message Type” is SLC Typed Read.  The Destination 
Element can be any integer array.  The 35 elements (total) read from 
the M4500 PLC are defined in the last section – Read/Write Data 
Definitions. 
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WRITE INSTRUCTION CONFIGURATION – CONTROLOGIX 
The write message (MSG) configuration for a ControLogix PLC is 
setup as follows: 
 

 
 
Note:  The “Message Type” is SLC Typed Write.  The Source 
Element can be any integer array.  The 5 elements written to the 
M4500 PLC are defined in the last section – Read/Write Data 
Definitions. 
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COMMUNICATION TAB - CONTROLOGIX 
The communication configuration for a ControLogix PLC is setup as 
follows: 
 

 
 
The “Path” describes the route the message takes to get to the 
destination. The format of the “Path” uses this format: 
port, next_address 
 
For serial DF1 communications, the port is “DF1 serial, channel 0” 
(Type = 2), next_address is for the station address (0-254). Since there 
is only the direct link from channel 0 to the User Port on the S4516-
DF1 board, the next_address is set for station 0. 
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TAG TAB - CONTROLOGIX 
The Tag configuration for a ControLogix PLC is setup as follows: 
 

 
 
Note:  The Tag “Data Type” must be MESSAGE and is defined at 
the “Controller” scope level.
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________________________________________________________ 
CHANNEL 0 SETUP 
 
PLC5 
The Channel 0 Serial Port should be setup as follows: 
 

 
 
Note:  The Communication Mode is setup for System (Point-to-
Point). 
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PLC5 
The Channel 0 Options are setup as follows: 
 

 
 
Note:  The “Detect Duplicate Messages” should be unchecked. 
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SLC500 
The Channel 0 Serial Port should be setup as follows: 

 
 
The Channel 0 Options are setup as follows: 

 
 
Note:  The “Duplicate Packet Detect” should be unchecked. 
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CONTROLOGIX 
The Serial Port (Channel 0) should be setup as follows: 
 

 
 
The “System Protocol” should be setup as follows: 

  
 
Note:  The “Enable Duplicate Detection” should be unchecked. 
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________________________________________________________________________________ 
READ/WRITE DATA DEFINITIONS 

 
Data Read From The M4500 (35 Elements) Is Defined As Follows: 

 
 M4500 Mapped PLC  
Description Add Add Add Function 
General:     
Speed, CPM (Resolver RPM) W182 W800 N7:0 R/O 
Resolver Pos. W180 W802 N7:1 R/O 
Number of Strokes (Lo, 0-9,999) W1100 W804 N7:2 R/O 
Number of Strokes (Hi, 10,000’s)  W1102 W806 N7:3 R/O 
Total Die Jams (Lo, 0-9,999) W1104 W808 N7:4 R/O 
Spare - W810 N7:5 R/O 
Die Jams Station #1 W1108 W812 N7:6 R/O 
Die Jams Station #2 W1110 W814 N7:7 R/O 
Die Jams Station #3 W1112 W816 N7:8 R/O 
Die Jams Station #4 W1114 W818 N7:9 R/O 
Die Jams Station #5 W1116 W820 N7:10 R/O 
Die Jams Station #6 W1118 W822 N7:11 R/O 
Die Jams Station #7 W1120 W824 N7:12 R/O 
Die Jams Station #8 W1122 W826 N7:13 R/O 
Die Jams Station #9 W1124 W828 N7:14 R/O 
Die Jams Station #10 W1126 W830 N7:15 R/O 
Die Jams Station #11 W1128 W832 N7:16 R/O 
Die Jams Station #12 W1130 W834 N7:17 R/O 
Die Jams Station #13 W1132 W836 N7:18 R/O 
Die Jams Station #14 W1134 W838 N7:19 R/O 
Die Jams Station #15 W1136 W840 N7:20 R/O 
Die Jams Station #16 W1138 W842 N7:21 R/O 
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 M4500 Mapped PLC  
Description Add Add Add Function 
Alarm Status: - W844 N7:22 R/O 

Spare (Bit 00) - B844.0 N7:22/0 R/O 
Timing Signal Fail (Bit 01) F8 B844.1 N7:22/1 R/O 

Clutch Output #1 Fail (Bit 02) F48 B844.2 N7:22/2 R/O 
Clutch Output #2 Fail (Bit 03) F49 B844.3 N7:22/3 R/O 

No Motion Alarm (Bit 04) F42 B844.4 N7:22/4 R/O 
Resolver Fail Alarm (Bit 05) F43 B844.5 N7:22/5 R/O 

Coil Stock O’Ride Mode Fault (Bit 06) F56 B844.6 N7:22/6 R/O 
Spare (Bit 07) - B844.7 N7:22/7 R/O 
Spare (Bit 08) - B845.0 N7:22/8 R/O 
Spare (Bit 09) - B845.1 N7:22/9 R/O 
Spare (Bit 10) - B845.2 N7:22/10 R/O 
Spare (Bit 11) - B845.3 N7:22/11 R/O 
Spare (Bit 12) - B845.4 N7:22/12 R/O 
Spare (Bit 13) - B845.5 N7:22/13 R/O 
Spare (Bit 14) - B845.6 N7:22/14 R/O 
Spare (Bit 15) - B845.7 N7:22/15 R/O 

Die Jam Alarm Bits (station 1 to 16) W104 W846 N7:23 R/O 
Cup Jam Alarm Bits (station 1 to 16) W106 W848 N7:24 R/O 
Spare - W850 N7:25 R/O 
Spare - W852 N7:26 R/O 
Spare - W854 N7:27 R/O 
Spare - W856 N7:28 R/O 
Spare - W858 N7:29 R/O 
Spare - W860 N7:30 R/O 
Spare - W862 N7:31 R/O 
Spare - W864 N7:32 R/O 
Spare - W866 N7:33 R/O 
Spare - W868 N7:34 R/O 
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Data Written To The M4500 (5 Elements) Is Defined As Follows: 
 

 M4500 Mapped PLC  
Description Add Add Add Function 
General:     
Spare - W870 N7:35 R/W 
Spare - W872 N7:36 R/W 
Spare - W874 N7:37 R/W 
Spare - W876 N7:38 R/W 
Spare - W878 N7:39 R/W 

 


